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Overview
The Task Manager solution organizes workflows inside and outside of OneStream. It provides

one place for administrators to manage and ensure the success of their processes.

With Task Manager you can:

l Assign tasks based on close or process start dates.

l Reference workflows to be completed or reassigned.

l Communicate using email and comments.

l View at-a-glance charts to see task status across individual preparers, approvers, and task

groups.

NOTE: Task Manager is compatible with the Modern Browser Experience.

Task Manager Guide 1

Overview



Setup and Installation
IMPORTANT: Task Manager cannot be used on applications with a custom weekly time

profile.

Use the following information to understand prerequisites and dependencies, plan your

installation, and configure the database server.

NOTE: Before beginning setup, verify that the SQL server has table creation rights on
the SQL database to create the custom tables.

See OneStream Solution Modification Considerations.

Dependencies

Component Description

OneStream 9.0.0

or later

MinimumOneStream Platform version required to install this version

of Task Manager.

NOTE: Upgrade to UTM PV6.6.0 SV102 before upgrading to any UTM 8.X version.
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Select the Task Manager Development
Location
Before installation, decide whether to build the solution directly in the Production OneStream

application or in a separate Development OneStream application. This section provides some key

considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a
Production application is that you will not have to migrate the resulting work from a Development

application. However, there are intrinsic risks when making design changes to an application used

in a Production capacity and it is not advised.

NOTE: OneStream strongly recommends that you implement the solution in the

Development environment with a fresh copy of the Production application before starting

work.

Development OneStream Application: As a best practice, use the Development OneStream
application to build the solution.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and

change data in the additional database tables used by Task Manager. If other OneStream

Solutions are already in the application, these adjustments may already exist.

See Solution Database Migration Advice.
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Configure the OneStream Application Server

Be sure that the security group settings include the users working on and setting up Task

Manager before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important to keep

the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who access
records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group who edit and maintain tables.

l Table Creation Group for Ancillary Tables: Administrator
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4. Restart Internet Information Server.

Install Task Manager
1. Access Solution Exchange

2. In the OneStream Solution Exchange, go toOneStream Solution> Financial Close
>Task Manager.

3. On the Task Manager Solution page, select the appropriate OneStream platform version

from the Minimum Platform Version drop-down list.

4. Select the most recent version from the Solution Version drop-down list and click
Download.

5. Log in to OneStream.

6. On the Application tab, click Tools > Load/Extract.

7. On the Load tab, locate the solution package using the Select File icons and clickOpen.

8. Click Load when the solution’s file name displays.

9. Click Close to complete the installation.

Set Up Task Manager
The first time you run Task Manager, you are guided through the table setup process.

In OneStream, click Community Solution > Dashboards > Task Manager > Task Manager.
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Create Tables and Launch Solution
1. Click Step 1: Setup Tables.

This step may be necessary when upgrading even if tables already exist. Task Manager

does not drop any tables that already exist, but modifies table structures and adds new

ones if necessary.
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2. When setup is complete, click Step 2: Launch Solution to open Task Manager.

Package Contents

The Dashboard Maintenance unit provides the user interface for Task Manager and includes the

required dashboard groups, components, data adapters, parameters, and files.
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Settings
The Settings page contains administrative settings for Global Options, Close Dates,

Categories, Instructions, Holiday Profiles, User Preferences, XFDoc Add-Ins, and Uninstall.

See:

l Global Options

l Reason Codes

l Close Dates

l Categories

l Instructions

l Holiday Profiles

l User Preferences

l XF Doc Add-Ins Settings

l Uninstall

Global Options
TheGlobal Options tab contains key properties that guide global Task Manager administration.
It should be the first page you access during initial setup and configuration of Task Manager.

NOTE: All Global Options settings are retained during solution upgrades.
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Solution Administration Group: Select the Platform Security Group whose members will act as

solution-level administrators for Task Manager. If (Unassigned) is selected, no solution-level

administrator access is enforced.

Solution User Group: Select the Platform Security Group that has the full set of users eligible for

assignment within Task Manager, including Preparers, Approvers 1–4, Viewer, and any

group-based assignments. This setting defaults to Everyone, and all user lists throughout the

Task Editor and Task Grid are automatically filtered to display only users who belong to this

group.

NOTE: The Solution User Group controls user availability for assignment only. It does
not restrict access to Task Manager.
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Task Administration Group: Select the Platform Security Group that defines the administrative

users for Task Administration. If (Unassigned) is selected, only users with solution-level

permissions may administer task structures and configurations.

Task Administration Expanded Access: Select this check box to enable users in the Manage
Task Administration security role to access the Categories and Instructions settings to add, edit,

and delete items. Categories and Instructions created by Local Admins will be accessible to all

users.

Email Connection: The named email connection to use for notifications. The name of the
connections in this drop-down menu are derived from the initial server configuration. See the

Installation and Configuration Guidefor more information on configuring an email connection on

your server.

Close Has Work Day Zero: Controls the numeric work day values and work day offsets when the
Due Date MethodGlobal Option is set to Derived.

l If selected, then Day 0 (zero) is considered the first day of the close in the Work Day list.

This is the default setting.

Example

Close Date = 7/1/2022

Task Work Day = 0

Task Start Date = 7/1/2022 (Close Date)

l If cleared, then Day 0 (zero) is not included in the Work Day list and Day 1 (one) is

considered the first day of the close.

Example

Close Date = 7/1/2022
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Task Work Day = 1

Task Start Date = 7/1/2022 (Close Date)

The Close Has Work Day Zero check box has no effect on negative task work day values.

IMPORTANT: Set this option at the beginning of the setup process and do not change it.
If you change this setting after creating tasks, then you must perform a mass update and

republish to change the value of all existing Day 0 (zero) tasks.

Due Date Method: Determines the process used to compute the start and due dates of a task in
relation to the configuration of close dates.

l Derived: The start date and due date use the following calculation to get their values:
o Start Date = Global Close Date + Task Work Day Offset

o Due Date = Start Date + Duration

l Explicit Day Map List: Looks up the start date in the Close Date (Day Map) field and
computes the due date the same as Derived. This method helps when requiring very
specific dates for certain months to avoid certain non-working days to apply offsets.

o Start Date = Day Map Close Date (looked up by theGlobal Close Day & Work Day
value)

o Due Date = Start Date + Duration

Holiday offsets are honored for both derived and explicit day map due date methods.

See Close HasWork Day Zero.

Published tasks display an error message in the Task Gantt Viewer if Close Date (Day Map) has

not been set up for a workflow period when the Due Date Method setting is set to Explicit Day Map

List.

Start Hour Method: Controls how to compute a the start and due date hours for a task.
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l Offset Close Start Hour: Derives the task start hour by adding the Task Work Hour Start

(offset, +2) value to the Close Start Hour value. If the Task Work Hour Start Offset value is

set to (None), then the start hour is the close start hour.
l Specific Start Hour: Task start hour is set to the specific value set in the Task Work Hour
Start (Specific Time, 9:00 AM).
All work hour time values must be specified in Task Manager (Coordinated Universal Time,

or GMT/Greenwich Mean Time) when defining the task.
Holiday Offset Method: Extends or shifts a task duration if the due date of the task falls on a
holiday.

l Shift Task Start: Shifts a task start date to the holiday offset days set up in the holiday
profile.

l Extend Task Duration: Extends a task duration to the holiday offset days set up in the
holiday profile.

NOTE: Holidays occurring during the task duration do not affect the task start or due
date values.

Allow Personal Task Groups: Controls access to the Task Administration page for users that
are not in the Manage Solution Setup or Manage Task Administration security groups. Select this

check box (default) to allow users that are not in these security groups access to the Task
Administration page. If not selected, only members of the Manage Task Administration security
groups or the solution administrator can access the page. Users who are not administrators can

only view their own Personal Task Groups. For more information, see Appendix C: Personal Task

Groups.

Edit Commentary: Select this check box to allow a Commenter to edit their comments.

See:

l Comments

l All Commentary
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Allow Task Forwarding: Select this check box to allow tasks to be forwarded to any role

(Preparer and Approvers 1–4).

NOTE: Selecting Cancel will revert properties to the last saved settings.

Reason Codes
The Reason Codes tab enables Administrators to manage the reason codes available to end
users, when rejecting a task. The table editor includes the following columns:

l Name

l Description

l Active

The following predefined Reason Codes are populated with an upgrade or new installation:

l Invalid Documentation

l Missing Documentation

l More Detail Required

l Other

Administrators can add, edit, delete, activate and deactivate Reason Codes. Duplicate Reason

Codes are not allowed and at least one reason code must be active.
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Editing a reason code does not affect the prior version of that reason code. The previous reason

code remains in the Task History grid.

Close Dates
Close Dates associates a workflow (WF) time with a specific date and time. You can use this date

and time to determine if someone is late with their assignments, regardless of their geographic

location.
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Task Close Dates Pane

WF Time
The workflow time period. Click Add to add one record here for each workflow time period.

Close Start Day (Server Time)
Set this to the date when the financial close starts for this workflow time period. Server time is the

time zone where the OneStream Application Server is located.

Close Start Hour (Server Time)
Set this to the hour of day the close starts. Server time is the time zone where the OneStream

Application Server is located.

Close Date (UTC)
No entry required. Saving the record calculates this. The Close Start Day (Server Time) and
Close Start Hour (Server Time) values convert to UTC equivalents so you can compare the

current time a task is due to this entry to determine when it is due or late.

Close Date (Day Map) Pane

Used if the Due Date MethodGlobal Option setting is set to Explicit Day Map List. You must
first create a task close date before creating a close date in the Day Map grid.

Work Day
Enter the work day for a close date. This can be any positive or negative numerical value.

Close Start Day (Server Time)
Set as the date when the financial close starts for this workflow time period. Server time is the time

zone where the OneStream Application Server is located.

Close Start Hour (Server Time)
Set as the hour of day for what time the close starts. Server time is the time zone where the

OneStream Application Server is located.
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Close Date (UTC)
No entry required. Saving the record calculates the close date (UTC). The Close Start Day
(Server Time) and Close Start Hour (Server Time) values convert to their Task Manager
equivalent values to compare the current time a task is due to this entry to determine when it is

due or late.

Import, Export and Template for Close Dates

You can export a close date for manipulation and re-import. A template is provided as a

convenience with examples. You can import an Excel file with the close dates and associated

close day maps included for update or to be added as new. The following describes each button

and expectations.

Import
Click Import to choose the Excel file with the task close dates and associated close date day
maps to update or add. Any close date day map item requires that the related close date exists

before loading. Remove any sample rows before importing. You must close the Excel file, or an

error occurs.

NOTE: No data imports from the Excel file worksheets if the import process encounters

an error. The errors are written to a text file that is accessible in your File Explorer import

folder.
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Export
Export manages exporting the selected task close date and any associated close date day map to

a CSV file to manipulate and import as an Excel file once named ranges are added. This extract is

not meant for creating new task close dates. To create new task close dates, use the provided

Excel import template.

See Template.

To add named ranges:

1. Save the CSV file as an Excel XLSX file.

2. Create an Excel named range for close dates.

a. Select cell ranges starting with the cell containing Application to the last row in the

last column of data before the rows that start with Close Date Day Map.

b. Create an Excel named range that starts with the letters xft, for example
xftCloseDate.

3. Create an Excel named range for close date items.

a. Select cell ranges starting with the cell containing Application below Close Date
Day Map to the last row in the last data column.

b. Create a separate Excel named range for day map rows that start with the letters xft,
for example xftCloseDayMap.

4. After entering Excel data and defining named ranges, save the file and close it before

importing.

For examples and default values to use, refer to the How To tab in the example template by
selecting the Template button on the Close Dates page.
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Template
OneStream provides an Excel template to import task close dates or close day maps. Use the

Close Date tab to enter updates to or add new close dates in the ranges between the blue lines.

Insert additional rows within this range to allow for more close dates. Remove sample rows before

importing.

Close Dates Tab

Close Day Map Tab

Use the Close Day Map tab to enter updates to or add new close day maps in the ranges

between the blue lines. Insert additional rows within this range to allow for more close day maps.

This tab works from a different named range and both are imported.
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The How To tab next to the Close Day Map tab explains how to use each field and gives

examples.

After entering data into the template, save and close the file before importing.

Multi-select is enabled on the Close Date (Day Map) pane. So administrators can select multiple

entries to delete.

Categories
Administrators can maintain a list of up to three categories as informational labels for tasks. The

application loads with the initial category value of None for each. Add additional categories by
clicking Insert Row or importing them from an .xlsx file.

NOTE: There can be only one category named None.
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Category 1, Category 2, Category 3

The list of categories maintained by your Task Manager Administrator and are used for

information labels for tasks.

Select Category 1, Category 2, or Category 3 to display the items in the category.
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Import and Export

Import
Click Import and select an .xlsx file. You can import to multiple categories at the same time. For
example, in this file, the Variance category is being added to Category 1, Category 2, and

Category 3.

You can update existing categories by using the same category name and changing the values in

the description and order fields.

You cannot have duplicate names within a category index. For example, this file is attempting to

create a category named Variance twice in the Category 1 index. This is not allowed.

Export
Click Export to export all categories to a .csv file.

Template
Click Template to use the template to create an import file.
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Categories Buttons

The Task Categories pane on the Categories settings includes a toolbar that lets you add, update,

and delete categories.

Insert Row

Click to insert an additional row, then enter the category, description, and order.

Delete Row

Select a row, then click . A row cannot be restored after it is deleted.

NOTE: You cannot delete a category if it is assigned to a task or has a published task
instance .

Cancel

If you've made changes, you can click to cancel all changes made since the last save.

Save

Click to save any changes made.

Category

The category’s name. Its value is required to save the category. You cannot create two categories

within the same category index with the same name. Special characters such as% are stripped

from the name. For example, EBIT and EBIT % are considered duplicate names. After saving, the

Category field is read-only.

Description

Text that displays when you configure tasks as the category.
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Order

Controls the order in which categories display in a drop-down list box. The lowest number displays

first. If the order of each category is set as the same number, the list sorts by description.

Instructions
Administrators can upload files containing instructions that can then be assigned to all tasks in a

task group or to individual tasks. Instructions can be used to provide critical information needed to

process a task.

Instructions files can use these file types:

l DOCX

l PDF

l PPTX

l RTF

l TXT

l XLSX
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After instructions are assigned to tasks and published, you can view them in the Instructions pane

of a task. You cannot edit the instructions.

PPTX and RTF file types are not viewable from within the task’s Instructions section. When

these file types are used, Task Manager prompts you to download the file when you click the Task
Instructions icon for a task.

See Instructions (tasks with instructions only).

NOTE: Instructions can only be updated at the task level when adding or removing
instructions via mass update.

File Name

Lists the file name and file extension of each instruction document currently used as a task

instruction.

Description

Any description added to the upload record of the instruction document.

User

The username of the person who uploaded the document.

Time Stamp (UTC)

The upload date and time for the listed document. This is determined by the time zone where your

OneStream Application Server is located.
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Task Instructions Icon Bar

All menu bar selections display when you select a task instruction from the list.

Upload
Allows you to navigate to and select the instructions file you want to upload to include in the task

instructions list.

When uploading a task instructions file that contains restricted characters, the restricted

characters are removed from the file name when uploaded, resulting in a different file name. For

example, if you upload a file named &Instructions&.xslx, the file becomes Instructions.xslx in the

OneStream database because the restricted characters (the two ampersands) are stripped from

the file name. Because instructions file names must be unique in the OneStream database, no

other instructions file named Instructions.xslx can be downloaded while that instructions file exists

in the OneStream database.

See also: The Restricted Characters section of theOneStream Design and Reference Guide for

a list of restricted characters.

See the Restricted Characters section of theOneStream Design and Reference Guide for a list of

restricted characters.See the "Restricted Characters" section of theOneStream Design and

Reference Guide for a list of restricted characters.

View
Select an instructions file, then click View to open the selected instructions file in the application

associated with the file type.

Delete
Select a file to remove from the task instructions list, then click Delete to remove it from the list.

This does not permanently delete the file, but removes the file name from the OneStream

database.
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IMPORTANT: You cannot delete instructions assigned to a task or task group in the
Task Administration page, whether it is published or not.

Holiday Profiles
Administrators can maintain a list of holiday profiles that you can assign to tasks. Holiday profiles

group individual holidays into logical groups. For example, you can have holiday groups that

include all holidays for a specific country.

Holiday Profiles Pane

The Holiday Profiles pane lists currently defined holiday profiles and contains the following

information for each holiday.

Profile Name
The name assigned to the holiday profile.

Description
An explanation of what types of holidays are stored within the profile.

NOTE: The Profile Name field cannot be left blank.
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Holiday Offsets Pane

These are the individual holidays that cause task due dates to be offset. Select the holiday profile

to which the holiday belongs, then click Insert Row in the Holiday Offsets pane to add a new

holiday. Offset task due dates allow additional time to prepare and approve tasks when the due

date falls on a designated holiday date.

Holiday Date
The calendar date of the holiday. Click in the field, then select the Calendar icon. Switch to the
appropriate holiday date within the calendar to select it.

NOTE: You can also manually enter the date by selecting in the cell and typing in the
holiday date.

Offset (Days)
Enter the number of calendar days that the due date adjusts by when a task due date falls on a

specified holiday date. A positive number moves the due date to a later date, a negative number

moves the due date to an earlier date.

Description
The name of the holiday.

Holiday Profiles Icon Bar

You can export a holiday profile to manipulate and re-import. A template is provided as a

convenience with examples. You can also import an Excel file with holiday profiles and holiday

dates included, either to update or to add as new. The following describes each button and

expectations.
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Import

Click Import to select the Excel file with the holiday profiles and associated holiday offsets you
want to update or add. Any holiday offset item requires that the related holiday profile exists

before loading. Remove any sample rows before importing. Make sure you close this Excel file

before importing, otherwise an error displays during the import.

See Import, Export and Template for Task Groups, Task Definitions and Task Dependencies.

NOTE: Excel file worksheet data does not import if the import process encounters an
error. The errors are written to a text file stored in your File Explorer import folder.

Export

This manages exporting the selected holiday profile and any associated holiday offsets to a CSV

file to manipulate and import as an Excel file once you add named ranges. This extract does not

create new holiday profiles. To create new holiday profiles, use the provided Excel import

template.

To add named ranges:

1. Save the CSV file as an Excel XLSX file.

2. Create an Excel named range for holiday profiles:

a. Select the cell ranges starting with the cell containing Application to the last row in

the last column of data in the row before Holiday Profile Items.

b. Create an Excel named range that starts with the letters xft, for example
xftHolidayProfiles.

3. Create an Excel named range for holiday profile items:
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a. Select the cell ranges starting with the cell containing Application below Holiday
Profile Items to the last row in the last column of data.

b. Create a separate Excel named range for holiday dates rows that starts with the

letters xft, for example xftHolidayDates.

4. After entering Excel data and creating named ranges, save the file and close it before

importing.

Template

OneStream provides an Excel template to import holiday profiles and holiday dates. Use the

Holiday Profiles tab to enter updates to or add new holiday profiles in the ranges between the

blue lines. Insert additional rows within this range to allow for more holiday profiles.

Holiday Profiles Tab

Holiday Dates Tab
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Use the Holiday Dates tab to enter updates to or add new holiday dates in the ranges between

the blue lines. Insert additional rows within this range to add more holiday dates. This tab works

from a different named range and both are imported.

You can update the offset integer for holiday date by clicking in the appropriate Offset cell and

entering a positive or negative whole integer. Once you fill out the template, save it and close the

file before importing. For examples and default values use, refer to the How To tab next to the
Holiday Dates tab.

Delete All

This lets you delete all holiday offsets for a selected holiday profile.

User Preferences
Users can set their default start page, scorecard, task status sync type, and time zone on this

page.

Task Manager Guide 30

Settings



Start Page

You can assign the default start page that displays when accessing Task Manager via Community

Solution. The start page options are: Task Analysis, Task Grid View, and Task Gantt View.

Simplified Scorecard

Select this check box to display the Simplified scorecard as the default scorecard to display.

See Scorecard.

Task Status Sync Type

Task status syncing is when the task preparation statuses for custom, workflow, and dependent

group task types are updated. When accessing Task Manager from Community Solution, all task

statuses update when you display the start page, including tasks that require syncing. The Task

Status Sync Type setting lets you determine when task status syncing occurs once the start page

fully loads.

Auto
Task status syncing occurs when:

l The Task Analysis, Task Grid View, or Task Gantt View pages load.

l Any of the menu bar task filters change.

l The Scorecard Task Detail dialog box closes.

Manual
Task status syncing only occurs when you click Sync Tasks and Refresh Page. Manual Task
Status Sync Type may be the preferred option when the Task Manager implementation includes

complex custom tasks.
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User Time

The user’s time zone in which they work. This drives task due date information (Start Date, End

Date) and converts the task due date info to the user’s time on the scorecard pages.

Daylight Savings

Select the Daylight Savings check box to adjust tasks times to reflect the daylight savings offsets
for the selected user time over any given year. If this check box is not selected, then tasks times

do not adjust for daylight savings.

NOTE: It is highly recommended to set the User Time value to the same time zone as
set on the user’s Date & Time settings for Microsoft Windows. If the user time is different,

tasks reflect inaccurate times in certain grids and charts across Task Manager.

XFDoc Add-Ins Settings
The XFDoc Add-Ins page lets you download the Microsoft PowerPoint and Microsoft Word XFDoc

Builder Add-Ins as a .zip file containing an Instructions file that walks you through the setup.
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Downloading the PowerPoint Add-In
1. Ensure Microsoft PowerPoint is closed. Click the PowerPoint icon in Task Manager XFDoc

Add-ins settings. The following Windows message is displayed.

2. ClickOpen.

3. Right-click to select the OneStream XFDoc Builder.ppam file and click Copy To.
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4. Use the Windows Explorer Copy dialog box to navigate to the location specified in the
Installation Instructions (C:\Users\<UserName>\AppData\Roaming\Microsoft), where

<UserName> is the name assigned to you by the IT department to identify your username.

The AppData folder may be hidden by default. To unhide it in Windows Explorer, click

View, then select Hidden Items.

5. ClickOK to select the location and close the Browse for Folder dialog box, then clickOK
to copy the file to the selected location.

Installing the PowerPoint Add-In

1. Open Microsoft PowerPoint and double-click Blank Presentation.

2. Click File>Options, and then click the Add-ins tab.

3. In theManage drop-down list at the bottom of the page, select PowerPoint Add-ins and
clickGo to open the Add-ins dialog box.

4. Click Add New and navigate to locate the file copied earlier. The OneStreamXFDoc

Builder.ppam file copied earlier displays.

TIP: Navigate to the C:\Users\<UserName>\AppData\Roaming\Microsoft\AddIns
folder if that is not the location of the folder.

5. Select the file and clickOK. OneStream XFDoc Builder now displays in the Add-ins as an

available add-in.

6. Click Close. The Add-ins window closes. The file is available from the Add-ins menu.
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Downloading the Word Add-In
1. Click theWord icon in Task Manager XFDoc Add-ins settings. The following Windows

message is displayed.

2. ClickOpen.

You can open the Word AddIn Installation Instructions.txt file for additional

information.

3. Right-click the OneStream XFDoc Builder.dotm file and select Copy To.

4. Use the Windows Explorer Copy dialog box to navigate to the location specified in the
Installation Instructions

(C:\Users\<UserName>\AppData\Roaming\Microsoft\Word\STARTUP), where

<UserName> is the username assigned to you by your IT department. If the STARTUP

folder is not visible, try closing Word before completing steps 1-6.

TIP: The STARTUP folder might be referred to by a different name depending on

the country in which OneStream is deployed.

5. ClickOK to select the location and close the Browse for Folder dialog box, then clickOK
to copy the file to the selected location.
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Microsoft Word add-ins deploy as global macro enabled templates and do not require additional

add-in activation steps. If Microsoft Word is open during the copy, you must close the application

and re-open it to see the newly added item.

XFDoc Builder Overview

The OneStream XFDoc Builder Solution simplifies the extensible document creation process with

new Microsoft PowerPoint and Word Add-Ins. These XFDoc Builder Add-Ins are only for use

within Word and PowerPoint documents that are associated with tasks. They are not meant to

author Extensible Documents outside of Task Manager.

NOTE: An error message displays if the XFDoc Builder Add-In tools are attempted to be
used in PowerPoint and Word on documents created outside the Task Manager

solution.

Using XFDoc Builder

Once you download and install XFDoc Builder Add-Ins (from Microsoft PowerPoint) and

templates (from Microsoft Word), use the XFDoc Builder solution to create OneStream Extensible

Document (XFDoc) in Task Manager.

See:

l OneStream Solution Modification Considerations

l Documentation Management for information on using the XFDoc Builder.
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Task Manager Security
Once you enter Task Manager via the Task Manager dashboard profile, you can see certain

tasks. Task visibility and the ability to execute, complete, and approve is based on the setup and

ownership of the task group the task is assigned to, as well as the specific task attributes.

Security in Task Manager is split into the following:

l Design

o Task Manager Security

o Task Security

o Dashboard Security

l Runtime

o Segregation of Duties

Task Security
Users are created and added to groups using the System > Administration > Security screen.
Individual users or groups are selected as Preparers and Approvers for each task.

See "Manage System Security" in the Design and Reference Guide for more information on

creating users and user groups and assigning roles to users.
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Dashboard Security
Default maintenance group security on the XFW Task Manager (UTM) Dashboard Maintenance

unit is set to Administrators. This should always be Administrators or another restrictive user
group to prevent unauthorized access and modification.

Segregation of Duties
Task Manager honors strict segregation of duties. If a person acting as a Preparer prepares a task

in any given month, they cannot approve the same task that month. If a user acting as Approver

approves a task in a given month, they cannot approve the same task that month at a higher

approval level.
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Task Administration
Click Show Task Administration Page in the Task Manager title bar to add and edit tasks and
perform other task processing.

l Users in the Manage Solution Setup security group (set in the Global Options page) can

view all task groups.

l Users in the Manage Task Administration security groups (set in the Global Options page)

can view only the task groups that are assigned a Local Admin group that includes the user

as a member.

l All other users can only access the Task Administration page if the Allow Personal Task

Groups option is enabled on the Global Options page. If the Allow Personal Task Groups

option is enabled, they can view only their own personal task groups, which have the user

assigned in the Access field.

NOTE: If the Allow Personal Task Groups option is turned off after non-

administrator users have created task groups, those task groups will be converted

to private access. Once it is converted to a private task, the user who

owned/created the task will become the Preparer of the private task.

See Security Roles and Appendix C Personal Task Groups.
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Manage Task Groups
To create a task group, click Insert Row in the Task Groups pane and enter the information,
including a unique name for each task group. Once this is complete, you can create and assign

tasks. Task groups can stand alone, but there is interdependency with tasks.
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Administrators can select multiple task groups to make updates and perform the following actions.

l Publish

l Import

l Export

l Template
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Task Group

Text field describing the group of tasks.

Frequency

Shows the workflow time periods in which the group of tasks are required to be completed. If your

application has monthly periods, valid entries are 1-12 (every month) or 3,6,9,12 to only require
the task quarterly.

IMPORTANT: Task Manager cannot be used on applications with a custom weekly time

profile.

Access

Determines who can view the tasks in the group. Select Public, Private, or User IDs from the

drop-down menu. Double-click in the Access column of a task group and select an option from
the drop-down menu.

Public
All users with access to Task Manager can see the tasks in the task group but can only process

tasks that they are assigned to.

Private
Filters task visibility in the task group to only Viewers, Preparers, and Approvers assigned to the

tasks.
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User IDs
Only Administrators and the assigned user ID can view the tasks.

Local Admin

Shows the group from the Manage Task Administration Security Role that is associated with the

task group. Double-click in the Local Admin column of a task group and select an option from the

drop-down menu.

Instructions

Displays the name of the Instructions file added to the task. You can assign instructions to all

tasks in a task group or individual tasks.

Once you upload instructions using the Instructions page, you can select them in either the Task
Group Instructions or individual Task Instructions drop-down menus. By default, tasks inherit
instructions assigned at the task group level, but can also be assigned no instructions, (None), or

a different set of instructions. Once instructions are uploaded, assigned, and their tasks

published, Viewers, Preparers, and Approvers can see the instructions within the task. Use the

Instruction page to upload and manage instructions.
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Deleting Instructions

When you delete a task or group from the Task Administration page, the assigned instructions will

not be deleted. The published task instance retains the instructions document.

IMPORTANT: If you forward a task in a private task group to a user not assigned to that
Task Group, the new task owner cannot see the task and cannot complete it.

See Instructions.

NOTE: For Instructions that use PPTX and RTF file types, you must open the file to view

it.
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Task Groups Button Bar

Insert Row
Add a new task group.

Cancel
Removes changes made to the task groups since the last save.

Save
Saves new groups or updated task groups.

Column Settings
This lets you select the columns to display in the Task Groups and Tasks panes of the Task

Administration page.
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Select tasks in either the Visible Columns list or the Hidden Columns list and use the arrows to
move the selected tasks from one list to the other. You can hold down the SHIFT key to select

multiple sequential tasks, or you can hold down the CTRL key and select multiple non-sequential

tasks.

Then use the arrows to move the selected tasks from one list to the other. Use the Add All Items
or Remove All Items arrows to move all items from one list to the other.

The Visible Columns list shows the order in which columns display. To reorder a column in the
display, select the heading name from the Visible Columns list, then use theMove Up andMove
Down buttons to set where the selected column displays.

See Group Items that Display in Grids.
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Toggle
Changes the percentage of the page that displays the Task Groups pane.

Task Group Icon Bar

Publish

Opens the Publish Tasks dialog box. This lets you publish the selected task groups or all task
groups for one or more time periods. Task groups and associated tasks are not visible to users on

the Task Grid View page until they are published.

Start Time – End Time
The workflow periods to publish task groups and tasks.
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Publish Scope
Whether to publish only the selected task groups or all task groups.

Publish Method
For the selected workflow periods, both the merge and replace methods create any new tasks and

task groups. For previously published tasks and task groups, the merge method will update task

attributes. However, the replace method overwrites tasks (including history) and sets the task

status to Not Started. The task comments persist.

The task comments, dependents, forwards, history, and status do not change when using the

merge method.

When you select Publish and Merge, dependency changes are enabled for Not Started and In
Process statuses.

Copy

Opens the Copy Group dialog box. This lets you copy a task group and associated task
information to a new task.
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Name
Enter a name for the new task group into which you want the selected task group and associated

tasks copied.

Access
Select a group or individual user that will have access to the new task group from the list.

Local Admin
Select a local admin group for the new task group from the list.

Role
SelectOverwrite User Roles to overwrite all security user roles for all tasks in the new task

group. If you overwrite user roles, all of the role assignments across all the tasks will be changed

to what is displayed in the Copy Group dialog box.
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Delete

Deletes a task group and all associated tasks and published task history for that task group.

Deleting a task group displays a message asking if you want to delete the group and all published

task history and displays the number of tasks, task instances, and number of time periods affected

by the deletion of task historical items.

Import, Export, and Template for Task
Groups, Task Definitions and Task
Dependencies
You can export a task group and all associated task definitions to manipulate and re-import. A

template is provided with examples for convenience. You can also import an Excel file with task

groups or task definitions that are new or updated.
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Import

Use Import to select the Excel XLSX file with the task groups and task definitions to add or update.

Any task definition requires that the related task group exists before loading. Remove any sample

rows before importing. Close the Excel file on your computer to avoid an error.

NOTE: Data from the Excel XLSX files worksheets does not import if the import process

encounters an error. Errors write to a text file that you can access in your File Explorer

import folder.

1. Click Import to open the Import - Tasks dialog box.

2. Select the import type from the drop-down menu.

3. Click Import.

4. Select the Excel file to import for use in Task Manager.

5. ClickOpen.

Task Manager Guide 51

Task Administration



Export

You can export a single task group or multiple task groups and their associated tasks and task

dependencies to a CSV file, which you can edit and add named ranges to and then import as an

Excel file.

1. Select a task group.

2. Click Export.

To add named ranges:

1. Save the CSV file as an Excel XLSX file.

2. Select the cell ranges starting with the cell containing Application to the last row in the last

column of application data.

3. Create an Excel named range that starts with the letters xft, for example xftTaskGroups.
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4. For task list and task dependency rows, create separate Excel named ranges that start with

the letters xft, for example xftTaskList and xftTaskDependencies. This works if they are
different than the first named range.

5. Once you enter the Excel data and define named ranges, save the file and close it before

importing.

Click Template on the Task Administration page to see the How To tab in the example
template.

Excel Template

OneStream provides an Excel template used to import task groups, task lists, and task

dependencies.

Excel Template - Task Groups Tab
Use the Task Groups tab to enter updates or add new task groups in the ranges between the

blue lines. Insert additional rows within this range to add more task groups.

Excel Template - Task List Tab
Use the Task List and Task Dependencies tabs to enter updates or add new task definitions in

the ranges between the blue lines. Insert additional rows within this range to add more task lists or

task dependencies.
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Excel Template - Task Dependencies Tab

Excel Template - How To Tab
The How To tab next to the Task Dependencies tab explains the use of each field and gives
examples.
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After entering data in the template, save it and close the file before importing.

Tasks
The Tasks pane on the Task Administration page lets you review and maintain tasks for a

selected task group. You can:

l Add a task

l Delete one or more tasks

l Edit one or more tasks

l Copy a task

l Add or remove dependencies for a task
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Tasks Pane Icon Bar

Add
Opens an empty Task Editor dialog box to create a new task.

See Task Editor.

Delete
Select one or more tasks, then click Delete. Click Delete again to confirm.

Edit
Select one or more tasks, then click Edit. The Task Editor dialog box opens and is automatically
populated for the selected tasks.

See Task Editor.

Copy (Task)
Select a task, then click Copy to open the Copy Task dialog box. You can use this feature to copy
the selected task to a different task group or to the same group with a new task name.
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Name: Enter a unique name for the task. The default name for a copied task is the original
task name with "_Copy" added.

Description: Enter a description for the task (optional). The default description for a copied
task is the same description of the original task.

Group: Select a task group. For reference, the task group that the task is being copied from
displays at the top of the Copy Task dialog box.

Preparer, Preparer Group, Approvers 1–4, Approver Group, Viewer Group: Use the
drop-down menus to assign a preparer, a preparer group, approvers, an approver group, and

a viewer group to the new task.

Depend
Opens the Dependent Task Manager dialog box for the selected task. Add or remove
dependencies for this task. You cannot complete this task until you complete its dependent tasks.

See:
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l Dependents (tasks with dependencies only)

l Dependent Task Manager

l Excel Template - Task Dependencies Tab

Tasks Pane Button Bar

Cancel
Removes changes made to the task groups since the last save.

Save
Saves new groups or updated task groups.

Column Settings
This lets you select the columns to display in the Task Groups and Tasks panes of the Task

Administration page.

See Column Settings.

Defer Refresh
Defers automatic refresh until you click Refresh.

Refresh
Refreshes the table editor.

Edit Task Information
Access the Task Editor from the Tasks Pane icon bar to add or edit tasks. Select a task and click

the Add or Edit icon and use the Task Editor to add or edit general information, scheduling and
action information, and an optional conditional status expression.
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NOTE: To change information in the Task Editor, select the check box above the
information to change, update the value, and then click Save. If you do not select the

check box, the Save button does not display.

NOTE: Task assignments are validated against the configured Solution User Group. If
an assigned user is removed from the Solution User Group or the user name is updated,

the assignment is cleared and must be reassigned.

Info

Use the Info section of the Task Editor to add general information about the task. The description

you add in this section displays in the task’s details.
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Task Editor Info Field Definitions

Info

Name The description that displays to users assigned to the

task.

Notification

Type

Configure when users are notified by email about task

changes.

l None

l On Preparation

l On Preparation, Recall, and Rejection

l On Preparation, Recall, Rejection, and Approval

l On Preparation, Recall, Rejection, Approval, and

Unapproval

See Set up Task Notifications.

Categories 1–3 The list of categories maintained by your Task

Manager Administrator. These categories are

informational only.
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Info

Instructions Select an instructions file from the list to use with the

task or select the default (From Group) to have the
task inherit any instruction files from its task group.

Instruction files that display in the list have been

uploaded and included as instructions for a task.

See:

l Instruction (tasks with instructions only)

l Instructions Settings

Description Enter text describing the task. Administrators can use

this field for quick task identification and for

understanding what the task is about.

See Set up Descriptions to Identify Tasks.

Role

The Role section of the Task Editor lets you set up the roles for the task. Each user can only

perform one role on a single task in a specific time period.
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Task Editor Role Field Definitions

Role

Preparer/Preparer

Group

The Preparer or Preparer Group assigned to prepare the task.
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Role

Approvers 1–

4/Approver Group

The user or group assigned to approve the task once prepared by

the Preparer.

There are different levels of approvers, and each approver has

specific permissions related to their role for a task. Multiple levels of

approvers are beneficial for complex tasks that require multiple

reviewers to ensure quality. Assign a maximum of four approvers to

a task.

A user can take action on a task as their assigned role or any role

below or act as preparer.

l Approver 1 on a task can approve at level 1 on that task.

l Approver 2 on a task can approve at levels 1 and 2 on that

task.

l Approver 3 on a task can approve at levels 1–3 on that task.

l Approver 4 on a task can approve at levels 1–4 on that task.

After a user prepares or approves a task, they cannot take action on

it again. An administrator cannot assign the same user to more than

one security role.

Approvers can run Document Management, Open URL, and Open

Dashboard tasks for review before approving. All other task types

require Preparer rights when running.

Tasks in public groups can only be run by a Preparer or Approver.

Viewers, Preparers, and Approvers can view the task.
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Role

Viewer Group The Viewer Group assigned to access the task.

Viewers can view task details, comments, attachments, and

instructions, but they cannot perform actions on tasks.

Approval Levels There are different levels of approval. Each level requires an

additional approver. Set this option to 0 to remove the requirement

for approval, which means the task only needs to be prepared.

Schedule

The Schedule section of the Task Editor lets you set up task scheduling, timing, and priority.
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Task Editor Schedule (UTC) Field Definitions

Schedule

Work Day Work Day is the number of days in relation to the period close date (0, +1, -

1) (-1, 0, +1). All dates and times used for comparison are based on UTC

(GMT) time zone for consistency. This can be any valid positive or negative

integer. Task Manager validates the value as a valid positive or negative

integer and displays a message if the value is not an integer.

Start

Hour/Offset

The time on the Work Day in user time that the Task is due. All dates and

times used for comparison are based on UTC (GMT) time zone for

consistency.

Duration The length of the task in hours or days.

Holiday Profile Select a Holiday Profile to assign to this task to offset dates.

Frequency Frequency is the workflow time period in which the task takes place. If the

task frequency is empty, the task will have the same frequency set on the

task group. If the frequency on the individual task is different from the task

group, it will show what the individual task displays.

For example, if the group is 1-12 and the task is set to 3,6,9, or 12, then the
task only shows quarterly.

Priority An informational indicator to users that enables them to prioritize their

work. Valid options are High, Medium, and Low.

Task Manager Guide 65

Task Administration



Schedule

Is Milestone When set to Yes, Is Milestone adds a diamond shape to the Gantt chart
indicating significant progress points that need to be met for success of the

task group.

Action

The Action section of the Task Editor is where you determine the action type of the task. The

selected action type determines the additional fields used to define how the task runs. The Action

section does not display if multiple tasks are selected for editing.
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Task Editor Action Field Definitions

Action

Action

Type

Action Type indicates the type of task to complete. One or more additional fields

can display based on the Action Type selected. Select the appropriate

information displayed in these fields to support the selected Action Type.

See Action Types.

Any security in place for each of these actions remains in effect. For example, if

creating a task that sends a user to a dashboard for which they do not have

access, they do not see any of the dashboard components.

Status and approval updates for tasks with certain Action Types happen

automatically when taking associated actions in OneStream. Other tasks must

have status and approval values updated manually.

Status

Use the Status section of the Task Editor to define any conditions required for the task.

Conditional Status Expression
Select Conditional Status Expression to create situational overrides for task dependencies.
Create an XFBR business rule that specifies what condition needs to be met and include the

conditional statement in the field.
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NOTE: XFBR is a script that you or the Administrator must create.

In the previous example,MyBRStringRule is the business rule name andMyBRStringFunction
is the function name.

NOTE: This conditional statement points to a custom XFBR business rule to suit the

conditional requirements. You can include additional rule arguments.

If the condition is met (success), nothing returns, and the associated task completes. If not met

(failure), the condition returns a string, and the custom statement displays in the business rule.

Include in this custom statement an explanation of why the task is running and the message to

display upon failure.

Conditional status is not meant to override task dependents. It is meant to add external

restrictions (for example, test if GL is closed before allowing workflow completion).

See documentation on XFBR Business Rules in the Design and Reference Guide for more

information.

Validation

The Validation section of the Task Editor shows the status of the selected task or tasks as well as

the summary of information from the other sections (Info, Role, Schedule, Action, and Status).

The grid displays errors related to security role validations. It will display in real time if any user is

assigned to more than one security role on the same task. Other validations are done to the name

and description fields (length, uniqueness, and special characters used that are not allowed) and

workday (validates it is an integer) that display in a message after you click Save. Only changes

with no errors are processed when you click Save.
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Right-click the row to export the information or change the column settings.

Action Types
This section details each task action type and the additional information needed to define the task

action.

No Action

Used as a reminder, typically something done outside of OneStream. No additional fields

requiring completion display when selecting this option.

Custom Task

Custom task lets you create the relationship between a task definition and a custom dashboard.

An available option includes a function to automatically update a related task’s state after

reviewing the Task Analysis, Task Grid View, or Task Gantt View page where this task is

listed.

Running a custom task opens the custom dashboard in a separate Task Manager tab, so you can

easily switch between the dashboard tab and the tab containing the task details.
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Dashboard
Choose a dashboard that displays relevant information. You can use any dashboard component,

such as running a report, cube view, custom table viewer, or URL.

Task Parameters
Specified task parameters pass to the dashboard or auto-status function. Syntax is to list the

parameter name passed and its value.

Auto-Status Function
OneStream calls this function when you open any of the Task Analysis, Task Grid View, or
Task Gantt View pages and update the custom task state.

You can optionally use the TaskName argument if the resulting auto-status function needs the
task name (or some other passed-in argument) to obtain the proper task state.
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Data Management

Enables you to run a specific data management sequence. This lets you run a predefined task in

Task Manager that you would normally not be able to access and run within OneStream.

Data Management Sequence
For the Data Management action type, select a data management sequence from the drop-down

list and select whether the sequence automatically executes.

NOTE: Data Management tasks do not process notifications as they auto complete. The
selected Data Management job must use a BR to send completion notifications.

Auto Execute
If No, the Preparer must run the task. Task Manager updates the task state to Prepared. The
Approver must still approve the task.

If Yes and the task has no predecessor tasks, the task runs when the Preparer accesses it. The
State and Approval values automatically update.

Dependent Group

Tasks can be made dependent on all tasks in a task group. You can set his dependency using the

action type of Dependent Group within a task definition.

Task dependencies can be applied by different methods:
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l Completing specific tasks in a task group

l To all tasks in a task group (dependent group)

l Using a conditional status filter expression

Group Name
The task groups that are available. You must also update the task group name in the Action

parameter on the Task Administration page if changing the task group name for any dependent
group.

Dependency Type
You can apply the dependency to all tasks or filtered tasks. If selecting filtered tasks, the filter

expression can be used to filter the tasks for the dependent group.

Filter Expression
Change dependency type to Filtered Tasks and click Build to open the Filter Expression
Builder dialog box. This lets you create an expression to meet the dependency requirement.
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The Filter Expression Builder dialog box lets you build custom filters.

Operators include And, Or, =, >=, <=, <>, = >, and <.

Click Close to write the filter expression back to the task action properties.

Dependent group action type tasks do not change to Prepared until all the underlying dependent
tasks are prepared. The approval status is Unapproved by default and changes to Not Required
when an underlying dependent task status is changed.

See Filter Items that Display in a Grid.

Document Management

This type of task opens the Document Management toolbar when executing the task.
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See Document Management.

Open Dashboard

Directs users to a specific dashboard in OneStream. Running an Open Dashboard task opens the

dashboard in a separate Task Manager tab, so you can easily switch between the dashboard tab
and the tab containing the task details.

Dashboard
Choose a dashboard from the list.

Open Page

Directs users to a page in OneStream, such as the FxRates page.
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Page
Select the OneStream application page.

Open URL

Directs you to the specified website.

Website URL
Provide the target URL. Ensure that the Preparer has access to any specified internal or secure

site.

NOTE: Some websites do not allow dashboard rendering and forces opening the

dashboard in a full screen. This can cause the OneStream page to navigate away from

OneStream instead of allowing the website to open in a new window. OneStream cannot

control this behavior. An error message may display in this situation.

Open Workflow

Directs users to open the specified workflow for the selected scenario and time.
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Workflow Profile
Select the workflow profile from the drop-down menu. The values are based on the Preparer

security. See Role.

Workflow Scenario
Select the workflow scenario from the drop-down menu. The menu allows piped parameters such

as |POVScenario| as well as a list of scenarios in OneStream.

Workflow Time
Select the workflow time from the drop-down menu. The menu allows piped parameters such as

|WFTime| as well as a list of workflow time periods in OneStream.

This task cannot be marked Prepared until the related workflow is marked completed (a check

mark indicates completion). Also, workflow tasks are not marked Prepared even if the workflow is

manually completed until all prior tasks have also been marked Prepared.

If instead of Prepared, you want the task to be marked Fully Approved after the workflow is

completed, set the Approval Levels field to 0. Otherwise, if the task is assigned to an Approval

Level of 1 or higher, the task requires approval after the workflow is completed. You can still

assign users to approval roles, but to move the task directly to Fully Approved, the Approval

Levels need to be set to 0.

Set Up Task Notifications
The OneStream Task Scheduler includes two sequences you can use to set up automatic email

notifications for tasks. A sequence is an ordered series of one or more steps that execute in the

order in which the steps are organized.
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When you install Task Manager, two sequences related to task notification emails are added to

the Platform Task Scheduler. The UpcomingTaskNotifications_UTM sequence manages

notification emails for tasks coming due within a specified number of days. The

PastDueTaskNotifications_UTM sequence manages when notification emails are sent for tasks

that are past due.

NOTE: The OneStream Task Scheduler is only available in the OneStreamWindows

application. OneStream encourages using the Windows application upon upgrade.

These sequences include default parameters and default values for the parameters. The

sequences are defined in the OneStream Data Management module, in the Task Manager Data

Management Group. In OneStream, click Application > Tools > Data Management to display
the Data Management pane. Then in the Data Management pane, click Data Management
Groups > Task Manager > Sequences to see the predefined sequences and their properties.
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See "Data Management" in the Design and Reference Guide for more information about the Data

Manager and Data Management groups and sequences.

Create a Task and Add the Task Manager Sequences

NOTE: As part of the Data Management job within Task Scheduler, first run the Task
Manager process to ensure all tasks are updated and synchronized to properly calculate

what is upcoming or past due.
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1. In OneStream, click Application > Task Scheduler to open the Task Scheduler. The Task
Scheduler Grid View displays the current list of scheduled tasks.

2. Click the Create Scheduled Tasks button to open the New Task dialog box, where you
can add information about the new task and schedule the notification emails.

3. In the Task tab, enter a name for the new task in the Name field.

4. The Start Date/Time field shows the time the task was created. This defaults to the current
date and time. You can change this if necessary.

5. In the Data Management groups tree view below the Sequences field, navigate to and
expand the Task Manager (UTM) Data Management group to display the

PastDueTaskNotifications_UTM and UpcomingTaskNotifications_UTM sequences.
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6. Click on each of the sequences under the Task Manager (UTM) Data Management group

to see the preset parameters and their values. If necessary, you can edit these values.

The following table describes the parameters for both Task Manager sequences and their

default values.

Parameter Description

WFTimeName Workflow time name. This specifies the time function to be

used when calculating tasks that are upcoming or are due.

The default value is |GlobalTime|, which references the

Global POV time.

See "Time Functions and General References" in the

OneStream Design and Reference Guide for more

information on various time functions that can be used as

values for this parameter.

TaskGroupName The name of the Task Manager task group containing the

tasks to execute the sequence against. The default value

is (All) which specifies that all task groups are checked to

see if this sequence applies to any of the group's tasks.

The Task Scheduler does not validate this parameter's

value. If specifying a single task group, ensure the value

exactly matches the task group name.
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Parameter Description

DaysPastDueMax

(PastDueTaskNotifications_

UTM sequence)

Represents the maximum number of days past the task's

due date in which past due notifications are generated for

the task. The default value is 30, which indicates that tasks

up to 30 days past due generate past due notifications

according to the task's schedule.

DaysPastDueMin

(PastDueTaskNotifications_

UTM sequence)

Represents the minimum number of days past the task's

due date in which past due notifications are generated for

the task. The default value is 1, which indicates that tasks

one day past due generate past due notifications

according to the task's schedule.

DaysPastDueMin works with DaysPastDueMax to define

the range of days for a task to be considered past due for

generating past due notifications.

So for example if DaysPastDueMin is 1 and

DaysPastDueMax is 30, then tasks that include this

sequence would start to generate past due notifications

one day after the task's due date, and continue to

generate past due notifications until the task is 30 days

past due.
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Parameter Description

DaysUntilDueMax

(UpcomingTask Notifications_

UTM sequence)

Represents the maximum number of days until the task is

due in which upcoming due notifications are generated for

the task. The default value is 3, which indicates that tasks

up to three days until the task's due date generate

upcoming due notifications according to the task's

schedule.

DaysUntilDueMin

(UpcomingTask Notifications_

UTM sequence)

Represents the minimum number of days until the task's

due date in which upcoming due notifications are

generated for the task. The default value is 0, which

indicates that tasks up to the day of their due date

generate upcoming due notifications according to the

task's schedule.

DaysUntilDueMax works with DaysUntilDueMin to define

the range of days for a task to be considered upcoming

due for generating upcoming due notifications.

So for example if DaysUntilDueMin is 0 and DaysUntilDue

is 3, then tasks that include this sequence would start to

generate upcoming due notifications starting three days

before the task's due date, and continue to generate

upcoming due notifications until the task is due.

NOTE: For the DayPastDueMax/Min and DaysUntilDue Max/Min settings, timings are
calculated based on the time zone of the user who creates the data management job

that uses the Task Manager sequences.
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7. Click on a sequence, then click the Schedule tab and use the radio buttons to specify the
frequency and recurrence of the task's execution.

8. ClickOK to save the new task and its schedule and include the Task Manager (UTM)

sequences.

The Task Manager Grid View reflects the days until and days past settings for each task in the

Days Until and Days Late columns.

In this example, if Days Until is 0 and Days late is 0 for a task, then notifications are set for tasks

due today. If days until is 1, that means the tasks for the sequence are due tomorrow. Days until

indicates when upcoming due notifications occur, and days late indicates when past due

notifications occur.
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Notification Emails

Upcoming and Past Due Notifications

Upcoming email notifications are sent to the current preparer if the preparer is a current user and

has a valid email address defined in OneStream. The current preparer for each task shows in the

Preparer column of the Task Grid View. If the task preparer is (Unassigned), the email is sent to
everyone in the preparer group. The current preparer can forward the email as necessary. Past

due task notifications are sent to the preparer and approvers 1–4. If the task approver is

(Unassigned), the email is sent to everyone in the approver group. See Appendix D: Notifications.

Email recipients only get one notification per day for all tasks that meet the notification

parameters. The email shows every task that they are the preparer or approver of that meets the

notification criteria. You can set up past due and upcoming due notifications at the same time

within the same job. Notification emails are sent from the OneStream OSUser address

(OSUser@onestreamsoftware.com).

For both upcoming due and past due notifications, the email shows the time period in the email

subject line. Tasks listed in the email are grouped in alphabetical order by task group.

The email for notification for past due tasks contains the word Urgent in the subject line. The
email notification for upcoming due tasks contains the wordWarning in the subject line.

Both upcoming due and past due email notifications list the following for each task:

l Group Name

l Task Name

l Description

l Priority

l Days Until Due (upcoming tasks)/Days Past Due (past due tasks)
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l State Text

l Approval Level

l Preparer and Preparer Group

l Approvers 1–4 and Approver Group

Action-based Notifications

Administrators can also set up action-based notifications in the Task Administration page.

Task Status changes are sent to Preparers and Approvers if the task or tasks are assigned to a

respective Preparer or Approver. Preparer and Approver groups will receive the emails if the task

or tasks are unassigned.
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See Appendix D: Notifications for information on which roles receive emails for each notification

type.

Manage Dependent Tasks
You can select a task and define dependencies with other tasks in the same task group.

Task Manager does not prevent creating task dependencies out of date order. For example, a

task that must be started on Day 2 can be created as a dependent of a task that ends on Day 4.

1. In the Task Administration page, select the task that requires a dependency association.

2. Click Depend to open the Dependent Task Manager dialog box.

3. Select the task you want to be a dependent from the Available Tasks column.

4. Click Add to move the selected task to the Dependent Tasks column.
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5. Repeat steps 3 and 4 as needed to add additional task dependencies to this task.

6. Click Close when all dependencies have been added.

You can also select a task and click Remove if you enter a task as a dependent in error. This
moves the selected task back to the Available Tasks column.

Changes to dependencies will not update tasks that are in Prepared states or higher.

NOTE: Tasks having dependencies cannot be set to prepared without all dependent
tasks being marked as prepared first.

See Tasks Pane - Task List Menu Bar.

Switch Between Task Analysis and
Scorecard Pages
Task Analysis displays Scorecard and Task Analysis pages to view task data across various

charts and grids. Additional Scorecard and Analysis icons in the Task Filtermenu bar let you
easily switch between Scorecard and Analysis pages.
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Task Filter Menu Bar
Task Filter menu bar items display on the Task Analysis, Task Grid View, and Task Gantt View
pages, as well as the Scorecard and Analysis pages. Scorecard and Analysis pages also
display any applied filters that update the tasks presented in the charts, grids, and counts for each

page. Navigating between the different pages in Task Manager automatically saves the filters.

Time

A list of monthly time periods. Select the time period for which you want to display tasks.

Role

A list of task ownership by role. Filter results by:

l Administrator (only displays for Administrators and Local Administrators)

l (All)

l Preparer

l Preparer (All)

l Approver

l Approver (All)

l Viewer Group

Preparer (All) displays any tasks assigned to someone who is the sole Preparer or as part of the

Preparer group. The same behavior applies when selecting Approver (All).
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Group

The list of published task groups that are accessible to the user.

Category Filters

Lists of Category 1, Category 2, and Category 3 for filtering. Any combination of these is

considered the intersection of these categories (an AND combination), not the super set of

categories that meet each specific entry (anOR combination).

Task Manager limits the Category filter results to the categories assigned to tasks the user has

access to. The Category filters reset to All when changing the task group filter.

Refresh

Select Refresh to synchronize all custom, workflow, and dependent group task action types and
refresh all task charts, grids, statuses, and counts.

Additional Information

The Task Filter Menu for Scorecard, Analysis, Task Grid View, and Task Gantt View pages

display the following results on the task filter menu bar (column filters are not reflected in the

statistics):

l Total: The count of total filtered tasks for the selected time period.

l % Done: The percentage of the total filtered tasks completed for the selected time period.

l Past Due: The count of total filtered past due tasks for the selected time period.

l Not Started: The count of total filtered tasks not started for the selected time period.

l In Process: The count of total filtered tasks in process for the selected time period.
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l Rejected: The count of total filtered rejected tasks for the selected time period.

l Prepared: The count of total filtered prepared tasks for the selected time period.

l Partially Approved: The count of total filtered partially approved tasks for the selected time
period.

l Fully Approved: The count of total filtered fully approved tasks for the selected time period.

Scorecard
The Scorecard provide charts that let you know immediately where tasks are in the preparation

and approval process. All charts in the different Scorecard pages have drill down capabilities.

Click on any chart bar, node, or pie area to drill down and display the associated tasks in the Task
Details dialog box. Task statuses derive from the user’s time set on the User Preferences page.

Scorecard

See: User Preferences
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The Scorecard page provides an overview of where tasks are in terms of preparation status,

approval status, and due date.

Each bar or pie piece in a chart shows the number of items in the section. You can also hover over

a piece of a chart to display a pop-up showing the number of items. Click a bar or pie piece on a

chart to display its tasks in the Task Details dialog box.

Preparation Status
This pie chart represents the total filtered task count by preparation status:

l Not Started

l Blocked by Dependent

l Rejected

l In Process

l Prepared

Approval Status
This horizontal bar chart represents the total filtered task count by approval status:

l Unapproved

l Partially Approved

l Fully Approved

l Not Required

Due Date Summary
This vertical bar chart represents the total filtered task count by past due, due within one day, or

due in two to five days.
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Work Day Summary
This vertical bar chart represents the number of filtered tasks across the workdays for the selected

time period. Select a column to display the tasks for that workday in the Task Details dialog box.

You can also hover over any bar in the chart to display the number of tasks belonging to each

preparation status.

Comments by Others
This grid displays when you filter on any role other than Administrator. Only administrators and

local administrators will see the Administrator option in the Role drop-down menu. All comments

made by other users to assigned tasks display in this grid. This grid works as a pivot chart, so you

can drag and drop columns to create groupings.

Like other grids with columns in Task Manager, you can group comments by any column or

column combination.

See Group Tasks that Display in Grids.

Timeliness Trend (Administrator role only)
This trend graph when you filter by the Administrator role. Only administrators and local

administrators will see the Administrator option in the Role drop-down menu. It displays the total

number of past due and on-time tasks for the selected time period over a trailing twelve-month

period. Select a node to open the respective Task Details dialog box.

Scorecard – Simplified view

The Simplified scorecard view is an alternative view that displays when you select the Simplified

Scorecard setting on the User Preferences page.

See User Preferences.
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Tasks by Priority
This pane displays a pie chart that represents the percentage of High, Medium, and Low priority

tasks. Hover over a section of the pie chart to see the number of tasks for the highlighted priority

type.

Click a section of the pie chart to display and work with tasks for the selected priority in the Task
Details dialog box.

Due Date Summary
Displays a bar chart that shows the number of tasks due in each of the next two to five days, as

well as the number of tasks due within one day and the number of tasks past due. Hover over a

section of the chart to see the number of tasks for the highlighted priority type.

Click a section of the pie chart to display tasks for the selected priority in the Task Details dialog
box.
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Preparation Status
This displays a bar chart that represents the number of Prepared, Blocked by Dependent,

Rejected, In Process, and Not Started tasks. Hover over a section of the chart to see the number

of tasks for the highlighted priority type.

Click a section of the pie chart to display tasks for the selected status in the Task Details dialog
box.

See Task Details.

Analyze Tasks
The Analysis page includes Explorer Pivot and All Commentary grids. You can reorder grids in
the Explorer Pivot and All Commentary pages.

See Reorder Grid Columns.

Explorer Pivot

A filtered grid of task data that can be pivoted by dragging a column header into the blue bar

above it. Filter data by selecting the filter symbol on each column header.
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See Reorder and Filter Grid Items Columns.

The grid data can be exported to Excel XML, CSV, Text, or HTML. Right-click anywhere on the

grid and select Export, and then select the data export type.

Timeliness Trend (Administrator Only)

Provides the total number of on-time and late tasks for the selected time period over the trailing

twelve months. Click on a node to open the Task Details dialog box with the filtered task list.
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All Commentary

Provides all task comments by task group, task, description and comment.

NOTE: Task comments only display in the period in which the task was created.

Task Details
Select a task or chart item in the charts to open the Task Details dialog box and display the
available task details for the selected task or chart item. Click on a column heading in the task list

to sort the tasks by that column.

See Group Tasks Using Column Headers.
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Refresh Task State

Click Refresh to update all task states in the Task Details dialog box, excluding tasks that require
syncing.

Select Tasks to Process

The leftmost column in the Task Details pane contains check boxes that let you select one or

more tasks to process. You can select multiple tasks and perform an action on all tasks.

See Process Tasks in Bulk.

Clicking anywhere in a task row selects that task and displays the task details. Click the check box

in the column header to select all tasks.

Task State Indicator

An icon in the State column reflects the task’s current state.
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Not Started : An empty circle icon indicates that no progress has been made on the task.

Blocked by Dependent : An orange circle icon indicates that the task is blocked because a

dependent task is open.

In Process : A blue circle icon indicates that the task is in process.

Rejected : A red circle icon indicates that task approval is rejected. You must complete the task

again and resubmit it for approval.

Prepared : A green circle icon indicates that the task has been prepared and is awaiting

approval.

Fully Approved : A green check mark icon indicates a completed and approved task. This

includes tasks where approval is not required.

Partially Approved : A green circle icon indicates that a task has been prepared but has

additional approval levels to complete before being fully approved.

Task Action Menu Bar

The Task Actionmenu bar includes the following buttons which display in context depending on
the type of task, its status, and the data about the task.

Icons in the Task Actionmenu bar display in green to indicate that the selected task includes
items represented by the icon. For example, the task shown in the Task Actionmenu bar above
(Detailed Capex Plan) includes dependents.

Details
Selecting this provides task details such as assignment by preparers, approvers, and preparer,

approver, and viewer groups, action type, action parameters, and history.
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Comments
Click Comments to review, add, and edit comments and share additional information about the
task. Any user can edit their own comments.

Click Insert Row to add a comment, then click Save. If needed, click Cancel to revert any
unsaved edits. Commenter and Time Stamp (UTC) column values default to the current user
and time and cannot be edited once saved.

Preparers can only add comments to tasks to which they are assigned and have a status of Not
Started or In Process. Approvers can add comments to tasks of any status.

Administrators and Approvers can edit their own comments until the task is approved. Preparers

can edit their own comments until the task is prepared.

You can edit your own comments, but you cannot update another user’s comments. To edit a

comment you added, select the comment in the Task Commentary pane, click in the comment
field to edit, and then click Save. The time stamp on the comment updates to reflect the latest edit
time.

Attachments
Use attachments to communicate and share additional information needed by those working on

the task. Use attachments to associate all supporting documents needed to properly process the

task. Task Manager supports a wide range of file types that you can attach to a task. Preparers,

Approvers, and Administrators can add an attachment to a task.

NOTE: All file types except XML can be used as attachments. There are no size limits,
however extremely large files may time out during the attachment process.
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Click the Attachments icon to display the Attachments and Attachment History panes.

The Attachments pane lists current attachments for the task and lets you upload additional
attachments or view and delete attachments for the selected task. Any files that have been

attached to the task display in the grid.

The Attachment History pane lists any attachments that are part of the task’s history.

You can only add attachments to tasks that have not been prepared.

Attachments Menu Bar

You can perform the following actions on task attachments when you select an attachment in the

Attachments list for a task.

Upload
OpensWindows File Explorer so you can navigate to and select a file to upload as a task

attachment.
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View
Opens the selected attachment in its native application so you can review and update the

attachment’s contents.

You can also view an attachment in the task’s attachment history. In the Attachment History
pane, select the attachment and click the View icon that displays at the bottom of the pane. The

attachment opens in its native application. You make changes to an attached file you are viewing

from the Attachment History pane, then save the updates and upload and attach it to the same
task instance, a different task instance, or any other task. This is useful for instance when you

have a document whose data changes on a monthly basis. You can select the current task, select

the attachment with the document in the Attachment History pane, make changes, then upload
the changed document as an attachment to the current task instance.
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Delete
Select an attachment in the Attachments pane, then click Delete to remove it from the list of

attachments associated with the selected task.

Dependents (tasks with dependencies only)

Click Dependents to display any dependent tasks that exist for the selected task. Define task
dependencies for a task using the Dependent Task Manager.

See Dependent Task Manager.

Two different views of dependent tasks display.

The left pane displays the entire hierarchy of the selected task’s dependents in a tree view. Use

the Dependent Tasks tree view for a quick overview of the relations between a task’s

dependencies and to understand the levels of the dependent task parent/child hierarchy. The tree

view shows all levels of nested dependency for the selected task.

The right pane lists each dependent task in a grid view.

These views allow you to assess the status of each dependent task and provide information about

when the dependent task is due and to whom the dependent task is assigned.

Like the Status column of the Dependent Tasks grid, icons shown next to each dependent task in
the tree view indicate the dependent task’s current status. In the following image, all dependent

tasks show a green check, indicating all dependent tasks are complete.

See Task Status Indicator.
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You can send an inquiry message directly from this page to the selected dependent task’s

Preparer. This lets you easily collaborate and share information about the task. To send an inquiry

message, select the task, then enter your message in the Inquiry field. Click Send to send the
message to the task Preparer. The assigned Preparer and Preparer group will receive a detailed

task status inquiry email.

Notifications only get sent to Preparer and Approver groups if Preparer and Approver are

unassigned for the task or tasks. If there is a Preparer or Approver assigned, the notification will

only get sent to them.
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The Dependents icon displays in green in the Task Action bar for tasks that have dependent
tasks.

NOTE: Tasks with incomplete dependent tasks cannot be approved.

If you delete a task that has one or more dependencies, all dependencies will be deleted. When

deleting a task that is a dependency of one or more other tasks, you will be prompted with the

following message:

Instructions (tasks with instructions only)

Instructions can be assigned to tasks. You can view any assigned instructions in the Task

Instruction viewer. Click to expand the Instruction viewer to the OneStream window size or

size as needed.
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See Instructions.

Forward
This icon displays if you have permission to forward the selected task. Forward lets Preparers and

Approvers reassign task instance ownership to a different Preparer or Approver in the selected

time period. Task forwarding does not change the task assignment for past or future time periods.

Preparer Group and Approver Group assignments are retained.

Select the role to forward from the drop-down menu. Forward lists are not based on security

access. If you forward a task to someone who does not have security access to the underlying

action, they cannot complete their action.

Task Manager Guide 105

Task Administration



When a task is forwarded to a new Preparer or Approver:

l The task displays in the list of the new Preparer or Approver.

l The new Preparer or Approver receives an email notification.

l There is an entry logged into the Task Detail History table.

l Forwarded roles are noted in the Task Grid page and the Assignment section of the Task

Details dialog box.

You can select multiple tasks to forward to a user. A validation message will display that indicates

if the tasks were forwarded.

A single email notification is sent highlighting each task that has been forwarded. The email

notification details the following information:

l Group Name

Task Manager Guide 106

Task Administration



l Task Name

l Description

l Preparation Status

l Preparation User

l Approval Status

l Approval User

Task status action buttons (Started, Not Started, Prepare)
Click Start to move the selected task’s status to In Process. Click Prepare to move the task’s
status to Prepared.

Execute
This button executes the task action for the selected task. Executed task actions differ based on

the Task action type.

See Execute Tasks for details on executing tasks based on task action type.

Execute is available for all users assigned as the Preparer of a task and all tasks types.

NOTE: The Execute button is hidden for tasks with the No Action task action type.

Execute Tasks

When you execute a task, the action taken to execute the task is based on the action type of the

task.
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Execute a Custom Task
Tasks with a Custom task action type display a dashboard in a separate tab when you click

Execute, so you can easily switch between the dashboard tab and the tab containing the task’s
details. Navigation and actions can be taken in the Task Manager dashboard.

Execute a Data Management Task
Tasks with a Data Mgmt task action type run a data management sequence in the background
when you click Execute. The OneStream Task Activity log reflects updated data management

sequence status.

Execute a Dependent Group Task
Tasks with a Dependent Group task action type show a Gantt view of the dependent group and

its tasks when you click Execute.

Click the ellipsis in the Details column to display a dependent task’s details in the same area. This
is helpful to see the dependent task details and take any actions on that task without having to

navigate away from the page.
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The preceding example shows the original task Disclosures executed, and the dependent task

Shareholder Letter is selected from the Gantt view to display in the page. You can also see any

cascading dependent tasks on the same page.

Execute a Document Management Task
Tasks with a Document Mgmt task action type display the Document Management menu bar
when you click Execute.

See Document Management Tasks.
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Execute an Open Dashboard Task
The OneStream dashboard displays in Task Manager tab when you click Execute, so you can
easily switch between the dashboard tab and the tab containing the task’s details. Navigation and

actions can be taken in the dashboard in Task Manager.

Execute an Open Page Task
Tasks with anOpen Page task action type open a specified OneStream page in a separate tab

when you click Execute.

Executing an Open URL Task
Tasks with anOpen URL task action type display the website in the task when you click Execute.
You can navigate and perform actions across the website in Task Manager.
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Executing an Open Workflow Task
Tasks with anOpen Workflow task action type open the specified workflow in a separate tab

when you click Execute.

Task State Actions

Preparers and approvers have different task actions that are available depending on the task

state.

Task Manager administrators can also access these actions for their own tasks or the tasks of a

preparer or approver. However, Segregation of Duties are enforced so that anyone acting as a

preparer who prepares a task in any given month cannot approve the same task that month even

if they are a Task Manager administrator. Only actions specific to the current task state display.

Preparer State Actions

Start
Sets the task state to In Process.

Prepare
Sets the task state to Prepared.

Not Started
Sets the task state to Not Started.

Recall
Sets a prepared task to In Process.

Approver State Actions

Approve
Sets the task state to Approved for the current approval level.
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Reject
Sets the task state to Rejected.

Unapprove
A task at Approval Level 1 reverts back to Prepared. A task at Approval Levels 2–4 reverts back to

the previous level (for example, level 4 reverts back to level 3, level 3 reverts back to level 2, and

level 2 reverts back to level 1).

See:

l Task Manager State Diagram in Appendix A for the different task states and task actions

available for preparers and approvers.

l Process Tasks in Bulk for information on bulk processing actions on tasks.

Preparation

The current task preparation state (Not Started, Blocked by Dependent, In Process, Rejected, or

Prepared).

% Prepared

The task prepared percentage for the selected time period.

Approval

The task approval status of Approved, Unapproved, or Not Required.
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Set Up Task Descriptions
Administrators can add descriptive text for a task. Use the Task Editor or the Description field in

the Task Administration task list to enter description for a task. Click in the description field of the

task to enter the description.

Task descriptions are a useful way for Administrators to quickly assess the nature of the task and

lets you communicate what must be done to work on or prepare the task.

Descriptions can only be entered by Administrators. After the task is published, task Preparers

and Approvers can view descriptions, but cannot add or edit descriptions.

The following image shows the Description field in the Task Administration task list.
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The default column ordering in Task Manager places the Description field in the Task List as the
rightmost column. You can click Column Settings in the task list and use the Column Settings
dialog box to move the Description field to where it can be viewed without scrolling the task list to
the right to see the field in its default column ordering location.

See Column Settings.

The following image shows the Description field in the Task Editor. You can use either the Task

Editor or Task Administration task list to enter descriptions for tasks that you manually add.

Task Manager Guide 114

Task Administration



Task Manager Guide 115

Task Administration



Task descriptions display in the Task Details pane of the Task Grid View and Task Gantt View
pages, so you can quickly assess the nature of the task. However, you cannot edit the

descriptions in the Task Details pane.

See:

l Task Editor

l Tasks
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Task Grid View
The Task Grid View provides a way for Viewers, Preparers, and Approvers to view and work on

their tasks from within a grid. Task Grid View and Task Gantt View are where Administrators

and task Preparers can do most of their task processing.

Use the first column in the Tasks pane to select multiple tasks to process by selecting the check
box for each task. All tasks can be selected by clicking the checkbox at the top of the multiselect

column.
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Tasks can be rejected from the Task Grid View page. If you reject a task, you will be prompted to

enter a reason code. You can optionally add commentary to the reason text field.

The reason code and reason text will be displayed in the Detail column of the History section for

the rejected task.
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The task list grid in the Task Grid View page works as a pivot grid, allowing columns to be

dragged to the top, creating groupings. Select any task in the grid to display the task details on the

bottom half of the page. The Task Grid View page reloads if any of the filters on the Task Filter
menu bar change or when you click Refresh.
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Task Gantt View
The Task Gantt View displays a Gantt chart with dynamic filters. Tasks presented on the Gantt

chart turn from blue to red when a task becomes past due. The Gantt chart displays the Task
Details pane on the bottom half of the page. The Gantt chart times are based on the user’s

computer time.

Title
The name of the task.

Details
Click the ellipsis button in the row of the task to display its details in the Task Details pane on the
bottom half of the page.

Image
An indicator showing the task’s state.

See Task Status Indicator for more information about each state indicator.
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%Complete
The percentage a task or task group has been prepared.

NOTE: If a group contains tasks that a user cannot access, those tasks are not
considered in the derived completeness calculation. This value matches the Scorecard

completion value for any given group.

Start
The local date and time the task is set to begin.

End
The local date and time the task is due to be prepared.
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Document Management
Use the Doc Mgmt action type to manage document workflow (such as all documents needed for

close).

NOTE: A Document Management task may only contain and manage a single

document for document revisions. Use task attachments if several files are required for a

task.

Preparers can create, check in, publish, and modify the documents. Approvers can only publish

documents, so they can be reviewed before approval is given.

Select a Doc Mgmt task in the Task Details dialog box to display its details on the bottom half of

the screen. When you click Execute, the Document Managementmenu bar displays.

Document Management Menu Bar

Check-In
Use this to check in a document from your local computer.
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1. Enter a check-in comment and click Check-in.

2. Navigate to and select the document and clickOpen.

History
Opens the Check-In History dialog box to check-in a document version previously used, that is

currently stored in history.

Check-Out
Use to check out a version of the document.

Undo
Use to undo document version checkout.

Publish
Use to publish the checked-in version of an XFDoc.

Delete
Deletes the document and all historical instances of the document associated with the selected

task.

Document Management Processes

See:

l Create a Document

l Check In and Publish a Document

l Check Out and Publish a Document

l Create a Combined Extensible Document
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Create a Document

1. OpenWord and create the document containing the information related to the task.

OneStream software components are added to the document with the XFDoc Builder Add-

In during check-out.

2. Save the document and note its location.

NOTE: Documents inserted into other documents must be saved with .xfDoc as
part of the file name, for example SouthHoustonSales.xfDoc.docx for a Word

document. Documents not stored in this format cannot be inserted in other

documents

3. Close the document.

Check In and Publish a Document

1. Click Check-In and enter a related comment In the Check-in dialog box. Click Check-in.

2. UseWindows Explorer to navigate to the location of the file being Checked-In (created in

the previous section) and select it.

NOTE: Documents being checked in must be closed before checking them in. An

error occurs if the document is still open.

3. ClickOpen to check in the document. The document displays in the task, with a status of
CheckedIn. The document displays a green check in the In column to indicate it is checked
in.
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The document is ready to be published if the document does not need any XFDoc

components added. Continue to the next step.

See Check Out and Publish a Document for instructions if you are adding XFDoc

components to this newly published document.

4. Select the newly checked-in document, then click Publish. The document opens and
displays in the program associated with the file type.

IMPORTANT: Published PowerPoint xfDocs do not open in their associated
program when using the Modern Browser Experience

5. Close the document. The status of the document is still CheckedIn and it has a green
check in the In column.

NOTE: Document file name suffixes change from .xfDoc to .xfTmp when checked

in.

Check Out and Publish a Document

If the document needs to be updated, it must be checked-out, edited, checked-in, and

republished. The XFDoc Builder add-in must first be installed as a Word add-in before using it in

Word.
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1. Click Execute to execute the task for the document needing updates.

2. Select the document version to be updated, then click Check-Out. The document opens in
the file's default File Viewer.

3. Make any required changes needed to the document.

If not adding components, proceed to step 7. Otherwise, proceed with the next step.

NOTE: The XFDoc Builder add-in must first be installed as a Word add-in before

using it in Word.

See XFDoc Add-Ins Settings for information on adding the XFDoc Builder add-in.

4. In Word, click Add-ins, then click the XFDoc Builder button.

5. Use theOneStream XFDoc Builder dialog box to insert components. Double-click the
content types to add them to the list of content items, and then click Insert.
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The document updates with the selected component information.

While the document is checked out for editing, the extensible functionality is not processed,

due to the .xfTmp in the file name. While editing the document, the extensible code is

visible, not the actual data.

6. Save the document. When saving the document in the same file location with its previous

name, select the Replace file option when prompted. The document automatically saves

with .xfTmp added to the file name.

7. Close the document.

8. Complete the steps documented in Checking-In/Publishing a Document to check the

document back in and publish it. When published, the document contains information

based on the components added and the formulas entered.
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Provide an explanation of what changed in the Comment field. Both versions of the

document display in the Document Management list.

Create a Combined Extensible Document

You can create a single document to display data frommultiple source documents. Each of the

source documents must have .xfdoc in the file name, be associated with a specific task, and

already be checked-in and published. Then you can combine multiple documents into a final

document. There must also be a task that creates and publishes the combined extensible

document already created.

NOTE: Combining oneWord document (Doc Management) task inside of another Doc

Management task (Word Document) using a version of Microsoft Word 2010 or earlier is

not supported.
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1. Create a blank document in Word to contain the combined documents.

2. Enter the appropriate information into the document.

3. Save it and note the location.

4. Launch the task for publishing combined documents.

5. Check in the document created in step 1 of this procedure.

6. Select the document that was just checked in and click Check-Out. A window displays with

options for the file being checked out.

7. ClickOpen.

8. Click Add-ins, then click the XFDoc Builder button.

9. In the XFDoc Builder dialog box, select Task Word (Document) as a content item.

10. Select the file to be inserted, then click Insert.

11. Select the next blank line in the document, then press Enter to move to a new line.

NOTE: Inserted files must be added on a separate line within the combined
document.

12. Repeat steps 8-11 as necessary to insert all documents.

13. Save the document.

NOTE:When saving the document in the same file location with its previous

name, select the Replace file option when prompted.

14. Close the document.

15. Complete the steps documented in Check In and Publish a Document to check in and

publish the document.

This example shows a combined document.

Task Manager Guide 129

Document Management



Task Manager Guide 130

Document Management



Manage Grid Items
Task Manager provides several features that let you group, filter, and display the data, items and

columns in the grid.

Group Grid Items
In Task Manager grids, you can drag and drop column headers to the dark blue bar on top of the

column headers to group and display grid items by the dropped column.

Any column or combination of columns can be used. For example, to group tasks by State Text

and Priority, first drag the State Text column head up to the bar at the top of the grid, then do the

same with the Priority column head. Dragging and dropping any column head to this area

changes it to the Grouped by bar and displays the column head names that you drop into it.

The following image shows the Task Grid View page with the tasks grouped first by State Text

then by Priority.
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Column groupings are updated and display as soon as the column is dropped into the bar. When

more than one grouping is used, groupings display as nested within its higher-level grouping. For

example, the previous image lists the tasks by state, then within each state, tasks are grouped by

the Priority.

Expand or collapse grouped items by clicking the Expand and Collapse widgets on the top left of
each grouping.

Any column groupings you make are retained between Task Manager sessions. Groupings stay

in place until you change them or remove them.

To remove a grouping, hover over the column group you want to remove, then click the x that

displays in the group box. You can also click the column group head in theGrouped by bar and
drag it anywhere outside of the bar to remove it. Removing all groupings restores the list to its

original state.
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You can also change the list of items within groupings between ascending order and descending

order by clicking the ascending/descending widget on the top of the column group box.

When grouping grid items by multiple groups, you can also easily change grouping hierarchy by

dragging and dropping a grouping box to the grouping level.

Filter Items that Display in a Grid
Grids allow you to use filters to display a subset of the grid’s items. This is useful when working

with large numbers of items in a grid and lets you easily focus on the items you need to work with.

Any column reordering stays in state until you change it. In other words, column ordering is

remembered and retained from session to session until changed.

Any grid with columns that include the Filter button in the column head let you use filtering

criteria to display the items that meet the filtering criteria you define for that column.

In any grid column, you can click the Filter button to display the Filter Criteria dialog box.
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Start by selecting the specific items to include in the filter. Items that you can choose from are

based on specific item values available in the selected column. You can select all items, specific

items, or a single item for filtering.

Use the remaining fields to optionally build a filter expression to further filter the items to display in

the grid. Use the fields to define the logical operators and relational operators in the filter

expression. When a logical operator requires a value, use the text box below the logical operator

list box to enter the value. Click the button next to the value if you want case matching to apply to

the entered value.

Click Filter to apply the filter to the selected task group or task list.
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Reorder Grid Columns
Each column in a grid can be moved, so you can customize the display order of columns. This is

useful with grids that display many columns, letting you customize the display order to see the

column data most important to you. This lets you move the most important columns to the visible

area of the grid, so you don’t have to scroll right and left to see those columns.

To reorder a column in a grid, click and drag the column heading to a new position in the grid.

Set and Order Grid Columns (Task
Administration only)
In the Task Administration page, you can use the Column Settings dialog box to determine
which columns to display and the left-to-right order in which the columns display. You can column

display and ordering for both the Task Group and Task list panes. This allows you to easily focus
on just the data you need to see to process your task groups and tasks.
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See Column Settings for instructions on setting Task Administration column ordering and display

using the Column Settings dialog box.

Task Manager Guide 136

Manage Grid Items



Process Tasks in Bulk
The Task Grid View and Task Details dialog box allow you to update multiple task states by

selecting the tasks, then applying one action to all the selected tasks. For example, rather than

selecting each task that needs approval and changing the task state to Approve one-by-one, you
can select all the tasks and approve them all in one mass action.

Processing tasks in bulk is an efficient time saver when you need to perform the same action on

many tasks. You can approve, unapprove, prepare, reject, or recall multiple tasks by selecting

them and performing a mass task status action on all the selected tasks at once.

All buttons display regardless of your role or the tasks' current states. Once you apply the action,

each selected task is validated against your rights and the task's current state. If you do not have

access to that action or the action does not apply to the tasks' current state, the selected tasks do

not update.

Task Manager states indicate where a task currently is in the task workflow.

See:

l Task Status Actions for a description of each task state by role.

l Task Manager State Diagram for an overview of the task status workflow.

When you select multiple tasks, the Task Detail pane changes to a grid listing all the selected
tasks. Task state icons display at the top to let you update all the selected tasks' states.
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See Task Status Actions for a description of each task status by role.

To update multiple tasks at once:

1. Select all of the tasks to process. You can select multiple tasks by:

l Click the first task in a consecutive range, hold SHIFT, and click the last task in the

range.

l Hold CTRL and select multiple, non-consecutive tasks.

l Click the check box in the leftmost column header. This selects all tasks in the list.

2. Click the applicable icon in the Task State menu bar to update the tasks. Only the actions

that can be taken on the selected tasks are made during processing.

When bulk processing, Task Manager considers the task dependencies, task type, the current

task state, and your role with the task to determine which selected tasks can be updated. Mass

actions cannot be applied to the following task types:
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l OpenWorkflow

l Dependent Group

l Data Management

l Any custom task that has any character in the Auto-Status function field

When the selected tasks are updated, a message displays showing the number of tasks that were

changed to the new state and the number of selected tasks that were not actionable and did not

update.

When you clickOK and apply the bulk changes, the top grid does not refresh. This is so you do

not lose their selected tasks in the list. However, the bottom grid of selected tasks does reflect the

state change. Click the Refresh button to update states in the top grid.
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Help and Miscellaneous
Information
This page contains additional solution documentation for Task Manager.

Display Settings
OneStream Solutions frequently require the display of multiple data elements for proper data

entry and analysis. Therefore, the recommended screen resolution is a minimum of 1920 x 1080

for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to

100% and do not apply any Custom Scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the Platform. Renaming

any of the elements contained in a package is discouraged in order to preserve the integrity of the

naming conventions.

Example Package Name:UTM_PV9.0.0_SV100_PackageContents.zip

Identifier Description

UTM Solution ID
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Identifier Description

PV9.0.0 Minimum Platform version required to run solution

SV100 Solution version

PackageContents File name

When you view the Task Manager Guide, the solution version is in the bottom left corner, and the

copyright year is in the bottom right corner.

Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom

tables such as this one. The relationship between OneStream objects such as workflow profiles

and custom solution tables is that they point to the underlying identifier numbers and not the

object names as seen in the user interface. Prior to the solution configuration and to ensure the

identifiers match within the development and production applications, the development

application should be a recent copy of the production application. Once the development

application is created, install the solution and begin design. The following process below will help

migrate the solution tables properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.

1. In the production OneStream application, install the solution and create the data tables.

See for Database Server Connection settings and installation details.
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2. Data tables are created in the OneStream Development application during the solution

installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to

the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator

should run the migration assistant.

IMPORTANT: This process has the potential to overwrite existing table data in the
production application database if data already exists.

OneStream Solution Modification
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

l Major changes to business rules or custom tables within a OneStream Solution will not be

supported through normal channels as the resulting solution is significantly different from

the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it or

copying it to a new object first. This is important because if there is an upgrade to the

OneStream Solution in the future and the customer applies the upgrade, this will overlay

and wipe out the changes. This also applies when updating any of the standard reports and

dashboards.

l If modifications are made to a OneStream Solution, upgrading to later versions will be more

complex depending on the degree of customization. Simple changes such as changing a

logo or colors on a dashboard do not impact upgrades significantly. Making changes to the

custom database tables and business rules, which should be avoided, will make an

upgrade even more complicated.
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Appendix B: Custom Event Model
You can add customizations to Task Manager that remain in place when you upgrade the

solution. Task Manager supports these models using business rules.

Set Up the Custom Event Model
1. On the Application tab click Dashboards > Dashboard Maintenance Units > XFW Task

Manager (UTM) > Files.

2. In the Files folder, click CustomEventHandler_UTM.zip.

3. In the Content File field, click the Download File button and save the file to your computer.

4. On the Application tab, from Tools click Load/Extract.

5. On the Load tab, use the Select File buttons to locate CustomEventHandler_UTM.zip and
clickOpen.

6. Click Load to import the business rule.

Integrate Business Rules
After importing the business rule, update the UTM_EventHandler business rule to integrate with

the CustomEvents business rule.

1. Click Application > Tools > Business Rules.

2. In the Business Rules Navigator, open the Dashboard Extender folder and click UTM_
SolutionHelper to display the Solution Helper properties.
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3. In theGeneral section of the UTM_SolutionHelper script Properties tab, add
BR\CustomEvents_TaskManager to Referenced Assemblies. Click Save.

4. In the Business Rules Navigator, click UTM_ImportExportHelper.

5. In theGeneral section of the UTM_ImportExportHelper script Properties tab, add
BR\CustomEvents_TaskManager to References Assemblies.

6. In the Business Rules Navigator, click UTM_EventHandler.

7. In theGeneral section of the UTM_EventHandler script Properties tab, add
BR\CustomEvents_TaskManager to Referenced Assemblies.
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8. Click the Formula tab to display the script and comment out line 42 of the UTM_
EventHandler business rule.

9. Uncomment line 43 of the UTM_EventHandler business rule. Click Save.

Once the custom event integration is set up, event actions can be defined in the CustomEvents_

TaskManager script.

NOTE: These events are not deleted or overridden when upgrading to new versions of

Task Manager. However, each time a new version is upgraded, apply these setup steps.

Available Custom Events

Before/After Selection Changed Events

The following events run before/after a custom control is clicked:
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l SaveSettings

l CreateSolutionTables

l ValidateSetupStepsExecuted

l Uninstall

l OnTableEditorOrGridSelection

l OnComboBoxSelection

l OnButtonClick

l OnShowContentPage

Before/After Save Data Events

The following events run before and after the save event for a table editor. Use these events to

test grid data prior to saving and potentially not allowing the data to be saved if a check fails.

l OnSaveOrUpdateTableEditor
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Appendix C: Personal Task
Groups
Functionality for administrators, local administrators, and users differs when personal task groups

are turned on or off.

See:

l Administrators

l Local Administrators

l Users

Administrators
The tables below describe functionality for administrators on the Task Administration page and

Task grid page when personal task groups are turned on or off.

Area Personal Task Groups On Personal Task Groups Off

Access drop-down options Public (Default)

Private

Any username

Public (Default)

Private

No usernames

Task Administration Page
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Area Personal Task Groups On Personal Task Groups Off

Local Admin drop-down

options

Defaults to Unassigned and

options include any platform

security groups that are

added to the Manage Task

Administration security role

in the Global Options page.

Defaults to Unassigned and

options include any platform

security groups that are

added to the Manage Task

Administration security role

in the Global Options page.

View and edit task groups All task groups (including

other users' personal task

groups)

All public and private task

groups (no personal task

groups because they do not

exist)

Action Personal Task Groups On Personal Task Groups Off

View and edit tasks All tasks (including other

users' personal tasks)

All public and private tasks

Task Grid Page

Local Administrators
The tables below describe functionality for local administrators on the Task Administration page

and Task grid page when personal task groups are turned on or off.
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Area Personal Task Groups On Personal Task Groups Off

Access drop-down options l Public (Default)

l Private

l Their own username

l Public (Default)

l Private

l No usernames

Local Admin drop-down

options

Options include any platform

security groups the user is

part of that are also assigned

to the Manage Task

Administration security role

in the Global Options page.

Defaults to the first group in

the list of Local Admin

options, not Unassigned.

Options include any platform

security groups the user is

part of that are also assigned

to the Manage Task

Administration security role

in the Global Options page.

Defaults to the first group in

the list of Local Admin

options, not Unassigned.

View and edit task groups Task groups to which they

are assigned the local admin

and any personal task

groups they created

Task groups to which they

are assigned the local admin

Task Administration Page
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Action Personal Task Groups On Personal Task Groups Off

View and edit tasks l Public tasks

l Private tasks to which

they are assigned as

local admin for the

task group

l Private tasks to which

they are assigned a

security role of

preparer, approver 1-

4, viewer group,

preparer group, or

approver group

l Their own personal

tasks

l Public tasks

l Private tasks to which

they are assigned as

local admin for the

task group

l Private tasks to which

they are assigned a

security role of

preparer, approver 1-

4, viewer group,

preparer group, or

approver group

Task Grid Page

Users
The tables below describe functionality for users on the Task Administration page and Task grid

page when personal task groups are turned on or off.
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Area Personal Task Groups On Personal Task Groups Off

Access drop-down options Their username only No access to page

Local Admin drop-down

options

Unassigned only No access to page

View and edit task groups Task groups that they

create

No access to page

Task Administration Page

Action Personal Task Groups On Personal Task Groups Off

View and edit tasks l Public tasks

l Private tasks to which

they are assigned a

security role of

preparer, approver 1-

4, viewer group,

preparer group, or

approver group

l Their own personal

tasks. Users can only

assign themselves a

security role of

preparer of personal

tasks.

l Public tasks

l Private tasks to which

they are assigned a

security role of

preparer, approver 1-

4, viewer group,

preparer group, or

approver group

Task Grid Page
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Appendix D: Notifications
Notifications can be set up by the administrator for notifications based on actions and both

upcoming and past due tasks. Notifications enable preparers and approvers (or users within the

Preparer Group and Approver Group) to be informed so they know if they need to take action on a

task.

The table below describes the notifications based on actions.

Action Recipient Additional Comments

Recalled Preparer If Preparer is Unassigned,

the notification is sent to all

users in the Preparer Group.

If there is no Preparer Group

assigned, no one receives a

notification.

Rejected Preparer If Preparer is Unassigned,

the notification is sent to all

users in the Preparer Group.

If there is no Preparer Group

assigned, no one receives a

notification.

Notifications (Action Based)
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Action Recipient Additional Comments

Prepared Approver 1 If Approver 1 is Unassigned,

the notification is sent to all

users in the Approver Group.

If there is no Approver Group

assigned, no one receives a

notification.

Approved Send to the next Approver For example, if Approver 1

approves the task, then

Approver 2 receives a

notification. If any Approver

role is Unassigned, the

notification is sent to all users

in the Approver Group. If

there is no Approver Group

assigned, no one receives a

notification.
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Action Recipient Additional Comments

Unapproved Send to the previous

Approver

For example, if Approver 2

unapproved the task, then

Approver 1 receives a

notification. If any Approver

role is Unassigned, the

notification is sent to all users

in the Approver Group. If

there is no Approver Group

assigned, no one receives a

notification.

The table below describes notifications for both upcoming and past due tasks.

Timing Recipient Additional Comments

Upcoming Due Preparer If Preparer is Unassigned,

the notification is sent to all

users in the Preparer Group.

If there is no Preparer Group

assigned, no one receives a

notification.

Notifications (Upcoming and Past Due)
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Timing Recipient Additional Comments

Past Due Preparer and Approvers 1–

4

If Preparer is Unassigned,

the notification is sent to all

users in the Preparer Group.

If there is no Preparer Group

assigned, no one receives a

notification.

If any of the Approver 1–4

roles is Unassigned, the

Approver Group is notified in

addition to any other primary

approvers assigned to the

task. For example, if a task

has three approval levels and

Approver 1 and Approver 2

are Unassigned, but

Approver 3 has an assigned

user, the Approver Group

and Approver 3 receive a

notification. If there is no

Approver Group assigned, no

one receives a notification.
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